Physics 6A Lab | Experiment 3

Newton’s Second Law
APPARATUS
Shown in the picture below:
• Air track, smart-pulley mount, and smart pulley
• Small glider
• Mass holder for gliders
• 5-gram mass hanger and three 5-gram disks

Not shown in the picture above:
• Computer and Pasco interface
• Large glider
• Scale and weight set
• Photogate and picket fence
• Rag box for collecting picket fence

INTRODUCTION
In this experiment, you will test Newton’s Second Law by allowing a falling weight (i.e., a known
force) to accelerate a glider of known mass along an air track. A string connecting the falling weight
to the glider passes over a smart pulley.
The smart pulley has low friction and low inertia, and its rotation is monitored by an attached
photogate. One arm of the photogate emits a thin beam of infrared light which is detected by the
other arm. The computer discerns whether the beam strikes the detector or is blocked by a spoke
in the pulley sheaf. The small LED light in front of one arm illuminates when the beam is blocked.
By accurately timing the signals that arrive from the photogate, the computer is able to track the
motion of any object linked to the pulley.
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THEORY
Consider a glider of mass M on a nearly frictionless air track. This glider is attached to a small
mass m by a string passing over a smart pulley. The Earth exerts a downward force on the small
mass which is equal in magnitude to its weight mg.

Reasoning somewhat intuitively, we can say that this gravitational force causes the entire system
of mass M + m to accelerate. Newton’s Second Law can then be written as
mg = (M + m)a.

(1)

More rigorously, let us draw free-body diagrams for each of the two masses. The forces exerted on
the small mass m are its weight mg (downward) and the tension T in the string (upward). These
two forces cause m to accelerate downward:
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X

Fy = mg − T = ma.

(2)

Note that we have assigned a positive sign to quantities pointing in the (downward) direction of
motion.
The forces exerted on the glider of mass M are its weight M g (downward), the normal force N
from the track (upward), and the tension T in the string (rightward). Since there is no motion in
the vertical direction:

X

Fy = N − M g = 0

(3)

or
N = M g.

(4)

In the horizontal direction,
X

Fx = T = M a.

(5)

The glider and small mass have the same magnitude of acceleration a since they are connected by
a taut string (of negligible mass). Adding Eqs. 2 and 5, we obtain
mg = (M + m)a
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as postulated above. Thus, the acceleration of the system is
a = mg/(M + m).

(7)

If we wish to test Newton’s Second Law, we might think of using different small masses m and
checking whether the acceleration a is proportional to the gravitational force mg. Eq. 7, however,
shows that a is not simply proportional to m, since the denominator also depends on m. Thus,
holding M constant while increasing m causes the total mass of the system to increase. On the
other hand, if we add, say, three more small masses (each of mass m) to the glider and transfer
them one at a time to the hanger (also of mass m), then the total mass M + 4m of the system
remains constant. Hence, we can test whether the acceleration of the system is proportional to
the gravitational force as it increases in magnitude from mg to 2mg, 3mg, and 4mg. (Note that
when using this method, you need to decide how many measurements to make before doing the
experiment, and then add the corresponding masses to the glider.)

INITIAL SETUP
1. Turn on the air track and level it by adjusting the leveling screw such that a glider on the
track has no apparent tendency to move in either direction. Since air tracks are often bowed
in the middle, place the glider at several different positions on the track to verify that it is
level.
2. Turn on the signal interface and computer, plug the smart pulley into the interface (inserting
the plug into digital channel 1), and call up Capstone and choose the “Table & Graph” option.
3. In the “Hardware Setup” tab, click on channel 1 and select “Photogate with Pully”. Click on
the “Select Measurement” button on the y-axis and choose “Position (m)”. Click the “Add
new plot area...” button above the graph twice to add two additional graphs. Plot “Linear
Speed (m/s)” on the y-axis of one graph and “Linear Acceleration (m/s2 )” on the y-axis of
the other.
4. Using approximately 1.5 meters of thread, connect the 5-gram mass hanger to a glider. Make
sure the thread passes over the smart pulley so the hanger will accelerate a glider down the
track.
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PROCEDURE
1. Weigh each glider to obtain its mass, and record the values in the “Data” section.
2. Attach (or tape) three 5-gram masses to the small glider, such that only the 5-gram mass
holder accelerates the glider. Turn the air-track blower on, and set one glider on the track as
far from the pulley as the thread allows. Click “Record”, and immediately release the glider
so that it begins to move. Just before the hanger hits the floor or the glider reaches the end
of the track, click “Stop”.
3. Check the graph window and use the “Scale-to-fit” button, if necessary. Check that you are
obtaining reasonable plots of the glider’s position, velocity, and acceleration. As usual, the
acceleration graph may look ragged.

scale-to-fit button at top left of graph tool bar
4. Read an “eyeball” value of acceleration directly from the graph (This is just an estimate) and
record this value in the “Data” section.
5. Click on the velocity graph then click on the “Highlight rang of points...” button. A box
will appear in the velocity graph. Drag this box over the data of interest (the linear part).
Click inside the box to highlight the data. Click the “Apply selected curve fits...” button and
select linear. A box appears telling you the slope of the best-fit line. Record this slope in the
“Data” section.
6. We will be recording and graphing data on an Excel spreadsheet. Call up Excel on your
computer. When the program has booted up, you will see a menu bar with a set of icons
above, and the spreadsheet cells in rows and columns below. Our plan is to record three trials
of the acceleration for the accelerating mass, and then to calculate the average acceleration
of the each of the three trials. Accordingly, prepare your spreadsheet like the one illustrated
below.

If you have not used a spreadsheet before, it consists of a sheet of cells labeled by the numbers
on the left and the letters on the top. You can enter numbers or text into the cells; the
numbers can be manipulated mathematically later. To make an entry into a cell, click on
the cell, and begin typing. The text appears on the menu line above, and you can edit it by
deleting parts, or by dragging through and typing the corrected material. There are at least
four ways of entering typed material into a cell: clicking on the green check, hitting “Enter”,
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pressing an arrow key to move to a nearby cell, or clicking on a new cell.
7. Make sure three 5-gram masses are still attached to the small glider, with the only 5-gram
mass holder hanging down. Set the system into motion. Obtain the acceleration as described
in step 5, and record its value in your spreadsheet. Perform a minimum of three trials. (As
data runs accumulate on your velocity graph, you can select run numbers in the box on the
graph and delete them to see the current data more clearly.)
8. Transfer one 5-gram mass from the glider to the mass holder, such that the holder and one
5-gram mass accelerate the glider. Set the system into motion, obtain the acceleration, and
record its value in your spreadsheet. Perform a minimum of three trials.
9. Transfer another 5-gram mass from the glider to the mass holder, such that the holder and
two 5-gram masses accelerate the glider. Set the system into motion, obtain the acceleration
as before, and record its value in your spreadsheet. Perform a minimum of three trials.
10. Transfer the final 5-gram mass from the glider to the mass holder, such that the holder and all
three 5-gram masses accelerate the glider. Set the system into motion, obtain the acceleration
as before, and record its value in your spreadsheet. Perform a minimum of three trials.
11. To calculate the average acceleration of the first three trials, in cell B7 of the Excel illustration
above, type the material between the quotes, “=Average(b4..b6)”, and click the green check
in the tool bar (or hit “Enter”). The equals sign signals Excel to do a calculation. This
operation will average the numbers in cells B4, B5, and B6. It does not matter that the B’s
are typed in lower case in the Average function. Note: If you set up your spreadsheet slightly
differently from the one pictured above, the relevant quantities may be in different cells than
listed in the preceding lines. In that case, you need to determine which (a) in which cell to
place the average function and (b) which cells to average over, in order to obtain your average
accelerations in an appropriate place.
12. Now comes the great virtue of spreadsheets. You do not need to type the Average function into
the cells for the other trials. Instead, position the cursor at the lower right corner of cell B7
(the one in which you just did the Average calculation), so that it turns into a lopsided square
shape. Now drag over cells C7, D7, and E7. Excel automatically calculates the averages of
the other trials with the proper cell references. (By the way, if you were now to change one tf
the values of the trial accelerations, Excel would automatically and instantly recalculated the
average.) Your spreadsheet should now look something like the illustration below:

(Dragging the calculation across the cells is called the “Fill Right” operation. There is also
a “Fill Down” operation for dragging a calculation down a column. Positioning the cursor at
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the corner of the cell is a short cut to these operations. They can also be accessed from the
“Edit” pull down menu.)
13. In cell A8 of the illustration above, type “Force (N)”. In cell B8, type the expression between
the quotes, “=B3*9.8/1000”. This will take the mass entry in cell B3, divide it by 1000 to
convert to kilograms, and multiply by 9.8 to convert to newtons. Then drag this calculation
across the other three cells C8 – E8 to calculate the force for each case.
14. We will now have Excel chart this data. First, if we leave the acceleration data above the
force data, the acceleration will be plotted on the x-axis and the force on the y-axis. Since we
consider the force to be the independent variable in this experiment, we would prefer it the
other way. Accordingly:
• Click the label “7” to select row 7,
• Pull “Edit” down to “Copy” (or simply hit CTRL+C, the control button and the C button
together, to copy),
• Select row 9, and
• “Paste Special” the “Values” into row 9.

(If you were to use “Paste” instead of “Paste Special”, Excel would have copied the cell
averaging formulas and averaged wrong numbers in row 9.)
15. Now we chart:
• Select the two rows of cells B8 through E9.
• In the “Insert” tab menu, select the “Scatter” option without connecting lines:
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• After clicking on this line-less scatter option, the chart should appear.
• From here (and whenever the chart area is active or highlighted) you can work with the
“Chart Tools”, which are organized by the “Design”, “Layout”, and “Format” tabs.
• Within the “Design” tab, in the “Chart Layouts” area, click on the left-most (and uppermost) layout option. This will place titles on the chart that you can edit or delete.
• Create your own title and labels for the axes.
16. Now we fit a line to the data; Excel calls this a “trendline”. While the chart area is active or
highlighted (click on the chart if you need to), select the “Layout” tab of the “Chart Tools”
and click on “Trendline” in the “Analysis” area. Select “Linear Trendline”. We want to find
to find a numerical expression for this linear fit to the data: Again, click on “Trendline”
but now select “More Trendline Options...”. In the pop-up window, make sure “Linear” is
selected, and check the box beside “Display Equation on chart”. Click on “Close”. Since we
are plotting a = F/mtotal , the slope of the equation (the factor multiplying x) is 1/mtotal .
Calculate this experimental mtotal , enter it in the “Data” section, compare it to the value of
mtotal obtained by weighing the glider plus the 20 grams of small masses used to accelerate
the glider (M + 4m), and calculate the experimental error. Show your results to your TA.

DATA
1. Mass of small glider =
Mass of large glider =
5. “Eyeball” value of acceleration =
6. Slope of velocity graph =
17. Experimental mass =
Experimental error =
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ADDITIONAL CREDIT: FREE-FALLING PICKET FENCE (3 mills)
Here you will need a photogate, a picket fence, and a rag box to catch the falling fence. The picket
fence is a strip of clear plastic with evenly spaced black bars. When the fence is dropped through
a photogate, the light beam is interrupted by the bars; since the fence accelerates while falling, the
bars interrupt the beam with increasing frequency. The software calculates the distance fallen, as
well as the corresponding velocity and acceleration. This acceleration should be constant and equal
in magnitude to g.

Under “Hardware Setup”, select “Picket Fence” to add the sensor. Insert the physical plug of the
photogate into the appropriate digital channel of the interface. Drag a new graph over from the
graph icon on the right side of the screen. Click the “Select Measurement” button on the y-axis
and select “Acceleration (m/s2 )”. Arrange the photogate in such a way that the falling picket fence
will be caught by the rag box on the floor.
Click “Record”, drop the picket fence through the photogate, and click “Stop”. Since the entire
motion occurs within a fraction of a second, you may not see much on the graph. Expand the
time scale using the “Scale-to-fit” button. Again, the acceleration graph may look ragged. Use
the “ Display selected statistics...” button to find the mean value of the acceleration. Record the
magnitude of the acceleration due to gravity with experimental error below.
Experimental g =
Experimental error =
This short experiment illustrates the power of computer measurement. It appears easy, but be sure
you understand what is happening in the measurement and can explain the results to your TA.
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